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AI and Proverbs: a case study 11/19/25 - 5:30 ETS Boston 

Ted Hildebrandt [ted.hildebrandt@gordon.edu] 

Biblicalelearning.org [BeL] → OT → Wisdom→ Proverbs 

1. Brief & Quick Intro. [A more thorough Introduction will be given if we have time]  

  1A.  Some Helpful Xn voices on AI: [John Lennox-Oxford Math/Apologetics,  

   Rosalind Picard [MIT], Drew Dickens, AI & Spirituality Podcast] 

  2A. Learning AI Resource options that will keep you up to date Youtube 

     1) Futurepedia Channel  

     2) Russell Stannard Teacher Training  

     3) Kevin Stratvert Channel -former MS engineer 

    4) Teacher’s Tech Channel  

    5) Boon Ai 

    6) Edcafe.ai – cf. Wordwall and Quizlet   

 

2. Proverbs Case Study – Introducing Biblicalelearning.org [BeL] Trad Resources 

   on https://biblicalelearning.org  

  1A. Introduce and Survey BeL [N. B. Dr. Bill Mounce’s great site as well –  

    https://biblicaltraining.org]  

   BeL– main headings navigation, some of the participants, vision, and  

    purpose 

 2A.  Two trad research resources biblical studies people overlook when 

   researching proverbs:  field of paremiology:   

   from Greek παροιμία (paroimía) proverb, maxim, adage) 

   1) R. C. Trench: Proverbs and Their Lessons, 1861. Gem 

   2) Wolfgang Mieder: best paremiologist in the world (Vermont) 

    a) The Wisdom of Many: Essays on the Proverb, Wolfgang Mieder 

    and Alan Dundes (eds.) Univ. Wisconsin Press, 1981. 

   b) Proverbs: A Handbook, Wolfgang Mieder. Greenwood Press, 2004 

   c) Twisted Wisdom: Modern Anti-Proverbs, W. Mieder and Anna  

    Litovkina, Univ. of Vermont , 1999.  

   Recent paremiology sources:  

   d) Proverbs Within Cognitive Linguistics: State of the Art (Cognitive  

    Linguistic Studies in Cultural Contexts, 16) by Sadia Belkhir  

    (ed.) John Benjamins Pub Co, 2024. 

https://biblicalelearning.org/elementor-97330/#BackToTop
https://biblicalelearning.org/
https://biblicaltraining.org/
https://en.wikipedia.org/wiki/Greek_language
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   e) Introduction to Paremiology: A Comprehensive Guide to Proverb  

    Studies, by Hrisztalina Hrisztova-Gotthardt and Melita Varga  

    (eds.) Sciendo, 2015.- free download:  

https://www.degruyterbrill.com/document/doi/10.2478/9783110410167/html   

 3A. Fun with Proverbs: Importance of culture when interpreting proverbs 

  1) Rolling stone gathers no moss:   

   England likes moss - keep changing things then moss  

    doesn’t have time grow (keep moving nothing grows, bad),   

  2) Scotland hates moss +  (keep moving otherwise you will stagnate)   

    Role of culture in interpreting proverbs 

 

  Proverb Variants/ Proverb twisting/proverbial imagination (Heim):  

    Happy wife, happy life,  

      Happy spouse, happy house,  

    Joyful mate, tranquil state 

  Biblical Examples: Knut Heim, Daniel Snell:  Prov 10:1, 15:20; 17:25  

   4A. Survey of BeL Proverbs Page Non-AI Trad. resources 

    1B. Authors (briefly – Knut Heim, Gus Konkel, Daniel Treier, Kyle  

     Dunham, and myself) -videos, audios, 12 languages et al.  

    Non-AI:  Hebrew Bible Speaker introduce and demo, Quizlet 

    Proverbs – Heim, Putnam, Treier, Dunham, Konkel, Hildebrandt 

     Online resources [sermons Hugenberger, Keller], Scanned  

     books/articles 

 Format:  Introducing 5 AI tools and how to build with them: 

  1) TurboScribe AI [Transcribing videos]; 2) NotebookLM [making study  

   guides, podcast summaries], 3) Gemini Storybook [Proverbial  

   Stories], 4) Suno AI [Make music – Wisdom’s Song], and  

   5) HeyGen to make Talking, lip-synched Avatars, 60 sec. shorts 

 Structure for each one:  

  1) Example: from Proverbs Web page on Biblicalelearning.org 

  2) Tools:  Name and URL – Use Youtube Tutorials to learn 

  3) Process:  walk through actually using the tool  

  

https://www.degruyterbrill.com/document/doi/10.2478/9783110410167/html
https://biblicalelearning.org/elementor-97330/#HebrewBibleSpeaker
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3. Exploring 5 AI’s Apps Harnessed for Doing Proverbs on BeL 

1A. TurboScribe: Video Transcriptions (STT), 12 Language Translations,  

    TTS: Text to Speech—back to 12 language audio 

  1B. BeL: Show BeL Example – Dan Treier’s 12-language 

    section Proverbs – Heim, Putnam, Treier, Dunham, Konkel, Hildebrandt  

   2B. Tools:  TurboScribe, Google Translate, MS Word  

    www.turboscribe.ai/dashboard,  

                                     https://translate.google.com/  

    MS Word 2024 in Microsoft Office  

   3B. Process:  

   1C. STT:  Speech-to-Text Transcriptions (TurboScribe):   

    OT Lit. extra-credit/8 hrs per. 

    iPhone – Messaging or Notes – click the microphone in the  

     lower right corner.  

     [many programs do this now (Youtube does it, Adobe  

     Premiere,WizWhisp - Transcribe Speech Offline free from    

     MicroSoft, Now Smart Audio Recorder can do it also 

     OpenAI Whisper has done millions of videos. )]  

    Process: TurboScribe.ai, www.turboscribe.ai/dashboard,  

       Video/audio input → output transcription 

     Click on Blue Button: “Transcribe Your First File” 

     Click on the “+” sign → Search for mp3 audio or a video file 

       OR “Import a link” – Paper clip upper right – uploads  

   Select “Whale *Most Accurate  

     Click “Transcribe” Button  

     Click Three dots “ …” on the right to “Export”  

     Pick “Export as DOCX” and click the Download  button 

      Should download to your “Download” folder in Windows 

2C. PROCESS: 12 Languages (using Google Translate: drop  

  the above Word (*.docx) document into Google Translate:  

 Select language:  Spanish, French, German, Arabic, Chinese,  

https://biblicalelearning.org/elementor-97330/#DanielTreier
http://www.turboscribe.ai/dashboard
https://translate.google.com/
http://www.turboscribe.ai/dashboard
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  Hindi, Korean, Persian, Polish, Portuguese, Russian, Swahili)  

     https://translate.google.com  

MS Word → Review → Translate →Document→ Pick language [free]  

Process:  
  Select “Documents”;  

  Select File (*.docx) From English: Input→ browse to your  

    English Version of the file 

  Select Lang. To: Swahili, Chinese…. to output to 

   Click the “Translate” button → Download   

  3C.  TTS: Text-to-Speech using MS Word  
     Rationale Theory: Audio/Secondary Orality – Walter Ong, 

     Brent Sandy, George Payton – Swahili,  Post-literate culture, 

     Opening it up to billions globally, listening in car commute 

    Tools: MS Word, Now Smart Audio Recorder  

     NowSmart Audio Recorder - Record Voice and Sound Easily – 

Free download and install on Windows | Microsoft Store  

    [AI can do this ElevenLabs*, HeyGen Avatar maker, Google AI   

     Studio, Gemini 2.5 Speech Generation (free), AI  

     [ https://aistudio.google.com/].  

     (e.g., Google Cloud Text-to-Speech, Amazon Polly, or  

     ttsmp3.com) can also create the MP3 audios 

    Be careful on character limits (I did 1 page at a time), time  

      length, paste-in-only no full *.docx or pdf full  

      document import, etc.  ]   

    Process:  MS Word is free and unlimited 

     Go to Microsoft Windows Settings → Open Microsoft Word  

     → Time & Language → Language and Region → Add a  

     Language → Add the desired language you want Text-to- 

     Speech enabled – it will take a download to install that.  

     Open your Foreign Language Document in Word: Spanish 

       Open Now Smart Audio Recorder.  Split screen so both are  

     open.  

     My method (free/unlimited-not best voices however):  

     Open Foreign Language Text in Word:  Say Spanish  

     MS Word → View → Immersive Reader)  

https://translate.google.com/
https://apps.microsoft.com/detail/9nmlxp17w2tm?launch=true&mode=full&hl=en-us&gl=us&ocid=bingwebsearch
https://apps.microsoft.com/detail/9nmlxp17w2tm?launch=true&mode=full&hl=en-us&gl=us&ocid=bingwebsearch
https://aistudio.google.com/
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     I then record it using “Now Smart Audio Recorder” app. 

 

    

  2A. NotebookLM Primer: Making Study Guides, Podcasts,  

    Summary Video, researching with it – Youtube search:  

    Youtube NotebookLM Tutorials 2025 to learn it. AMAZING tool  

    and Simple to use like having your ownpersonal research assistant  

   

   1B. Show BeL example: Knut Heim’s Videos: study guides &  

    podcast summaries 

     Proverbs – Heim, Putnam, Treier, Dunham, Konkel, Hildebrandt 

   2B. Tool:  Google’s NotebookLM   https://notebooklm.google.com 

    

   3B. Process: go to  https://notebooklm.google.com 

    Click, My Notebooks,  Create New” button for new notebook 

   Upload sources: [single Pdf transcription of the video in my case] 

    Can load up to 300 multi-modal resources [text (pdf, docx, txt),  

     Youtube videos, audio-mp3, web site, Multi-modal input] 

    Or click Discover Sources and it will search the web for sources 

     on the topic you want, research assistant 

   Dashboard has 3 Columns: - often start from the left and work right 

    1) Sources: Left Input Column – up to 300 multi-modal  

     resources [text, video, audio: Multi-modal input]  

    It will also look up and research input sources for you automatically 

     – I uploaded pdf transcription of a Proverbs video  

     2) Chat: Middle Column: Titled Abstracts generated over all  

     300 sources, you can ask questions, normal LLM Chatgpt  

     kind of questions over your input resources 

     I ask it:  “Produce 5 FAQs with answers from the sources”  

      Produce 10 multiple choice questions, give answer and  

     source citation  

     Copy result → Paste into a Word docx document.  

    3) Studio: Right Output: Column  
     *Reports – Briefing Document, Study guide; can 

https://biblicalelearning.org/elementor-97330/#KnutHeim
https://notebooklm.google.com/
https://notebooklm.google.com/
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      also now do: Core Concepts, Explanatory Notes,  

      Scholarly Review 

     Mind Maps, Quiz-interactive instant feedback  

     Flashcards: Question/Answer/Explain 

    Audio Overview!!! – Podcast dialogue format – Amazing! 

    Video Overview!!! –generates a video based on resources – 10 mins 

   Share: gives link or sends it to an email address so others can 

     see the Notebook you’ve generated.  

    Settings:  can output to many different languages beyond English 

    Copy Abstract, Briefing Documents, Study Guide, FAQs paste 

     into Word document (*.docx)  

     Ctrl +c (to copy) Ctrl+v (to paste) – sorry 

    Download the mp3 podcast summary  

    

  3A. Proverbial-based stories → philosophy-proverbs as compressed  

   stories;  e.g. 1 Sam  - “Is Saul among the prophets, Carol Fontaine’s  

     Traditional Sayings. 

   Old Method in OTLit. Semester project–days and days – Now AI – 2 hrs 

 

   1B. Show Example of Stories from BeL web page/Youtube.  
   Proverbs – Heim, Putnam, Treier, Dunham, Konkel, Hildebrandt  

     Youtube video: https://youtu.be/nHAcAO4t3qI - Proverbs 10:11 

  2B. Tools: Chatgpt [for storyline] – ChatGPT.com, Google’s Gemini Storybook 

    Google Gemini – https://gemini.google.com/u/1/app    

    Just found new possible tool:  ReadKidz – some better features 

    just found this 11/6/25 - explosion of new tools… also VideoExpress 

 

   3B. Process:     

    1C. Chatgpt:  Prompt to develop the storyline/plot/characters:  

    to make the story and post video on Youtube.  

    “Write a 500-word creative story built off Proverbs 19:2,    

    “Enthusiasm without knowledge is no good; haste makes mistakes.”  

     Cite the proverb itself in the story.” 

 

https://biblicalelearning.org/elementor-97330/#CreativeProverbialStories
https://youtu.be/nHAcAO4t3qI
https://chatgpt.com/
https://gemini.google.com/u/1/app
https://gemini.google.com/u/1/app
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    [optional: put the story in a family, business, school context, age 

    of audience] 

    Often will do this story development 3x and pick the best one 

 

   Cut/paste into MS Word for editing: refine it, get words and characters 

    working better [nudging: making it a little better than it was]   

    Save as → Word *.docx file and also *.pdf Acrobat file format 

  2C. Open Gemini 2.5 → click the hamburger menu upper left →  

    Storybook:  (I paid $20/month for pro version) to develop the  

    illustrations and make the flip through storybook.  

    Storybook Prompt:  

“Develop a storybook exactly word-for-word on the text from the attached pdf 

document. Use Anime Art Style for the illustrations. Give it the title: "The 

Stonecutters Life-giving Fountain - Proverbs 10:11”. Make it 17 pages long. Make sure 

the last two pages follow exactly word-for-word the text of the attached pdf 

document.” – can specify context if you want:  home, family, school, business, … 

 

Click the “+” button to attach the pdf document developed in Chatgpt.   

 Go wait 5 minutes, makes a storybook, Click the “Listen” button to hear it read. 

 

  Make changes: Corrective Prompts:  

  “Keep the story book exactly the same except for these three changes: 1) Split 

page 16 into two pages". 2) on page 16 change the text “Proverbs 10:12" to Proverbs 

10:11." And 3) on page 10 have the illustration of Zoe have only two arms instead of 

three.” Run through changes 1-4 times with corrections-fewer the better 

 

  Recording and Posting the Video:  

  1) Print Screen button on function row at the top of your keyboard Prt Scr [Print  

   Screen]→ Select Video Camera icon.   

  2) Then select by dragging the area for copying your screen 

  3) Hit the “Start” button to record wait until it countdown is over and click  

   the “Listen” button in the Storybook program (upper right)  

  4) Wait 3-4 minutes while it copies the video (mp4 format), Stop the recording. 

   Saves it automatically [Snip program does] 

  5) In File Explorer → Videos → Screen Recording Folder→ move file to folder  

   where you want it.  
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  6) Import and Edit the video in Adobe Premiere and Export it as mp4 1920x1080  

   video high definition.  Trim beginning, end, cut out any pauses,  

  7) Post the video on Youtube, link it into the playlist on Youtube, and link to it  

   from the BeL web page.   

  Congrats:  process takes about 2 hours per story.   

Another Process for AI Bible story video development: VideoExpress.ai - All-in-One 

Text To Video AI or https://youtu.be/Hizc2QZ4_t0?si=wonyNA9vbjhJil6t  

 Write powerful scripts with ChatGPT, Design characters with Leonardo AI, Animate 

scenes using Vheer or Hailuo AI,  Add lifelike voiceovers with ElevenLabs, Edit 

smoothly in CapCut  

4A. Suno AI music creation: https://suno.com  - to learn it watch 3-4 

   Youtube Tutorials – Why? People love music  

  1B. BeL Example of “Wisdom’s Song:  

    Youtube: https://youtu.be/JLwKIK-VVxA  Example of other music genres on  

   BeL:  Proverbs – Heim, Putnam, Treier, Dunham, Konkel, Hildebrandt 
 

  2B. Tools:  Chatgpt, Suno AI: Suno | AI Music  https://suno.com  

3B. Process:  

  1) I made Initial lyrics:  4 song verses and 1 chorus built off Wisdom’s speeches  

   Prov. 1:20-22;  2:4-5;  9:1-6, 10. 

  2) Put into Chatgpt and told it to enhance into a song – it added rhyming et al.  

  3) Spent a week or so messaging, editing, and enhancing the lyrics line by line  

 4) Drop the lyrics into Suno AI 

  5) Set the style:  “Country-Influenced Soft Rock, Acoustic guitar, light drums –  

   exclude fiddle”  Advanced:  male voice 

  6) Made AI music in several different styles: rhythm and blues, acapella, … 

  7) Downloaded the mp3 music file and post on BeL.  

  8) Developed pictures in Photoshop (Edit→Generate) – Photoshop is way behind 

    should have used Google’s Nano Banana or Mid-Journey to  

    make the images  

  9) Imported the music audio and pictures into video editing program (Adobe  

   Premiere…there are cheaper video editors now available everywhere) 

  10) Exported the Video *.mp4 and uploaded it to Youtube & linked it into BeL 

   along with many other styles on the same song: orchestral choir, bluegrass,  

   ballad duet, acapella, rhythm and blues, et al.  

https://videoexpress.ai/
https://videoexpress.ai/
https://youtu.be/Hizc2QZ4_t0?si=wonyNA9vbjhJil6t
https://suno.com/
https://youtu.be/JLwKIK-VVxA
https://biblicalelearning.org/elementor-97330/#Wisdoms_Song
https://suno.com/
https://suno.com/
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5A.  Making Youtube 60 second Shorts via Lip-synched Avatar from  

   the 3 hour video, Why? —3 hr. lectures are too long for some  

  1B.  BeL:   https://biblicalelearning.org/elementor-97330/#TedHildebrandt  

     

  2B. Tools:  Using HeyGen [vid. Youtube tutorials on working with HeyGen]-  

   Free to try/$29/month for Creator level, Creates Lip-synched Avatars 

   https://heygen.com  

   

  3B.  Process: login:  
   Dashboard: From NotebookLM have an Abstract paragraph ready  

    to be used as a script.   

    “Create” button: → “Quick Avatar Video” 

    Pick Avatar person:  click the + and pick a “Public Avatar” (each  

     public Avatar person has 20 types of clothes/settings look. 

     Public Avatars are unlimited video generations 

          Pick a “Look” from the many styles of your chosen Avatar 

    → Click: Next: Add Script button → Paste in a script [Abstract  

     from NotebookLM] 

          Edit in Studio: Select the Captions style that will appear as  

      the Avatar speaks – available when pick Avatar –  

      Brandon on menu across over the avatar’s head  

     Pick a background image.  

    “Preview” to hear voice (upper right) 

    Click on the created video to give it a title. (upper left) 

    Notice you can translate it into many languages. (button upper left) 

   Click Button: “Generate” to make the Video (upper right) →”submit” 

    Click Check box on the left of the video you’ve made 

    Click on the Image of the video you’ve made (can edit it again) 

    Click on Download  (upper right)  

   Upload the downloaded video to Youtube and link into BeL web page 

Invitation to participate in BeL by contributing expert lecture series: 

I generally now pay $150 per lecture. Often in the summer, I travel to your place and 

shoot 4-5 lectures a day ($600-750 per day).  I’ve got surveys for most of the biblical 

books covered, but I’m looking for specialized studies in each book or topic.  Email me if 

you’re interested: ted.hildebrandt@gordon.edu 

https://biblicalelearning.org/elementor-97330/#TedHildebrandt
https://heygen.com/
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AI Tools Survey that you may find helpful 

Discover Methodology: 1) Search and find the best AI tool for what you want to do.   

  2) Youtube several tutorials to learn the AI software 

  3) Try the AI software using the “Free” version → Purchase the one you like 

Learning AI options, teaching, and Tutorials from Youtube   

     1) Futurepedia Channel – 20 videos on all aspects of AI 

     2) Russell Stannard Teacher Training Videos 

     3) Kevin Stratvert Channel → videos 

    4) Teacher’s Tech Channel→ videos 

    5) Boon AI → videos 

Christians Resources on AI: John Lennox-Oxford Math/Apologetics, Rosalind Picard  

  [MIT], Drew Dickens AI & Spirituality Podcast] 

General AI   Large Language Models [LLMS]:  

  1) Chatgpt 5 (Open AI): https://chatgpt.com/  

  2) Gemini 2.5 (Google):  NotebookLM* Incredible & easy 

   https://gemini.google.com/app   

  3) Grok (Musk):  https://Grok.com  

  4) Claude 3.5 (Anthropic): https://claude.ai  

  5) Llama 4: MetaAi powered by: https://Meta.ai  

  6) Perplexity AI:  https://www.perplexity.ai specializes in research 

   A next-gen AI search engine with smart  

   citations and research-friendly features. 

Specific AI Tools: 

  Speech to Text (STT):  TurboScribe.ai, www.turboscribe.ai/dashboard, many  

   programs can do transcription now. 

                            or OpenAI Whisper (accessed through Google Drive…) 

 

   Batch Convert MS Word (*.docx) files into Acrobat pdfs.  

        Doxillion Document Converter Plus by NCH Software 

                              https://www.nchsoftware.com/documentconvert/index  

  Text to Speech (TTS): HeyGen, Synthesia, Chatgpt and Gemini Studio can do this 

   I use Free: MS Word → View → Immersive Reader → Read Aloud  

   (e.g., Google Cloud Text-to-Speech, Amazon Polly, or  

  ttsmp3.com) can also create the MP3 audios 

 

https://chatgpt.com/
https://gemini.google.com/app
https://grok.com/
https://claude.ai/
https://meta.ai/
https://www.perplexity.ai/
http://www.turboscribe.ai/dashboard
https://www.nchsoftware.com/documentconvert/index
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   Image Generators: Mid-Journey*, Chatgpt image generator,  

    Firefly/Photoshop-not the best, Ideogram, OpenArt AI*  

     Gemini’s Nano-Banana*, Gemini Storybook*-consistent characters 

  Audio Generators: Eleven Labs,* I use HeyGen* to generate Avatar voices, 

      Synthesia, Clonevoice.ai 

  Music Generator:  Suno AI*, Udio*, Aitubo.ai, AIVA, and Soundful, Musicgpt,… 

  Video Generators:  Veo-3 [Google]*,Hailuo 02, Runway Act 2, Capcut, 

     Sora OpenAI, Synthesia [lip synch, Avatars], Artlist,  

     Invideo AI, KlingAI, Pippit, OpenArt.ai, Davinci Resolve, et al. 

     [Text to video, image to video, multi-modal] 

   Video editors: Capcut, Filmora  

  Lip-synched Avatars Videos: HeyGen*, Synthesia, Creatify, Joggai, Kling,  

    Higgsfield, AI Studios, Kling, Dzine, Hedra, VEO3, Runway 

  Google’s Gemini 2.5:  NotebookLM is an AI-powered research assistant designed  

   to help you refine and organize your ideas.  

   [Input: 50 resources (pdf, videos, audios, images);  

   Outputs: 1 paragraph abstract/summary, study guides, podcasts, videos]  

    Google - Storybook – will demonstrate these two in depth 

    Readkidz – better but pay by chara                 qcter… or 

https://videoexpress.ai  

  Workflow builders:  Zapier, n8n, [Automations: fixed workflow, Agents are  

   dynamic they can reason, choose…]  

  Vibe Coding: AI Coding Tools: natural language builds code for you  

   1. Visual Studio Code (VS Code) 

   2. JetBrains IDEs does Python,…  

    3. Base44.com it leans more toward “idea-to-app” rather than “code-all- 

    the-things”. 

  Other Tools that may be useful:  WordWall, Edcafe.ai, Quizlet, Grammarly  

3 Skills to master:  Prompting [Aim, Context, Rules, Styles], Tools, Workflow [breaking  

  large tasks into units and then finding apps to implement that workflow] © 

  

https://videoexpress.ai/
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Bloated Introduction to AI in General: I’m afraid I won’t have time for this 

1. Anecdotal Intro - search for NT: Men’s group West Church Peabody,  

   MA.  

   Rom. 9:33/Isa. 28:16 “God warned them of this in the Scriptures  

    when he said…”But anyone who trusts in him will never be  

    disgraced/be put to shame.”   

    καὶ ὁ πιστεύων ἐπ’ αὐτῷ οὐ καταισχυνθήσεται.  

   Isa. 28:16 “Behold, I am the one who has laid as a foundation  

   in Zion, a stone, a tested stone, a precious cornerstone, of a  

    sure foundation, Whoever believes will not be in haste.”  

ין     ִ֖ אֲמ  מַּ ַֽ א  הַּ ישׁ ל ֹ֥ ַֽ יָח   

   Chatgpt: Give me examples in the NT when the LXX diverges from  

    MT given, 32 pages of responses; Gives references (NT → OT)  

    LXX, MT and Differences, built charts: NT source / OT Source;  

    LXX Reading; MT Reading; Theological Implication 

   Skipped Mat. 3:3 LXX: The voice of one crying in the wilderness:  

    “Prepare the way of the Lord → Isa. 40:3 “A voice cries: “In  

    the wilderness prepare the way of the Lord” – when I  

    pointed that one was missed it congratulated me on an  

    excellent example 

    

 2A. History to 4th Industrial Revolution: Convergence of digital, physical &  

   biological; AI, Blockchain, Robots, Internet of Things  

   The Internet of Things refers to a network of physical devices, vehicles,  
   appliances and other objects embedded with sensors, software, and  
   connectivity that allows them to collect and share data over the Internet.  
   Blockchain: Blockchain is a digital ledger database that records  
   transactions in a sequence of blocks, which are then distributed across a  
   network of participating computers, known as nodes. This technology  
   is decentralized, meaning it operates without the need for third-party  
  intermediaries, and immutable, meaning  once data is recorded, it cannot be  
   altered. 
    Alphabet [1800  BC] 

    Scrolls→Codices/Books [100 AD] 

   Printing Press 1440 AD, PC 1974-76,  

   Internet [ca. 1990] WWW, Mosaic 1993/Netscape 1994],  

     Explorer 1995, Safari 2003, Google(Search  
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     1998) Chrome 2008, MS Edge 2015]  

   Cloud [AWS 2006, GCP 2008, MS Azure 2010; DropBox]   

    4th industrial revolution: AI [Chatgpt,2022],  

3A. What is AI, AGI, ASI?  

  Definition : Artificial intelligence (AI) is the theory and development of  

  computer systems capable of performing tasks that historically required  

   human intelligence, such as recognizing speech, making decisions, and  

   identifying patterns built off LLMs [Large language Models] and NLP  

   [Natural Language Processing], often Multi-modal input/output [text,  

   audio, video, image].  

    Artificial Intelligence: AI:  Chatgpt 2022  

    Artificial General Intelligence: AGI : Chatgpt 5 / Grok 4 2025 

    Artificial Super Intelligence:  ASI : ? 2027- 2028 

 4A. General tools (Strengths/weaknesses) 

   Examples: Google Translate, Tesla: Uses  computer vision to power  

   self-driving autonomous features on their cars.  

   Optimus Robots [clean house, do the dishes so you can do more  

    meanful things]- compare wash/drying machines,  

   Reading 100,000s of X-rays [Lennox],  

   Computers & simulating emotions: Ros Picard, etc.   

  
   Raises existential/theological questions: vid Drew Dickens “AI &  
    Spirituality” podcast; Ray Kurzweil’s book:  Spiritual Machines, 1999. 
    What does it mean to be human?  
    What kind of relationships can one have with such systems?  
    What about when the computer gets smarter than we are?   
    Will such systems delete humans after they surpass us?  
    What will we humans do when AI takes all the jobs? 
 

  5A. Learning AI Resource option and Tutorials from Youtube 

     1) Futurepedia Channel  

     2) Russell Stannard Teacher Training  

     3) Kevin Stratvert Channel -former MS engineer 

    4) Teacher’s Tech Channel  

    5) Boon Ai 

    6) Edcafe.ai – cf. Wordwall and Quizlet   

   Free Courses on AI: 
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    1) Youtube: You’re Not Behind (Yet): How to Learn AI in 29 Minutes 

      https://youtu.be/9c7zh2MkslY?si=cl8kB4tQE3bceQHQ  

    2) Machine Learning Crash Course – https://developers.google.com/   

    Machine Learning  |  Google for Developers – 12 units   

    3) Machine Learning Course for Beginners – 10 hrs. video 

     https://youtu.be/NWONeJKn6kc?si=U-YAvBm_KI0wuUSR  

6A. AI Acronyms and basic concepts:  [Resource Drew Dicken’s first 7 podcasts  

  [AI & Spirituality on Spotify] 

  LLMS: Large Language Models – data collection,  

   GPT-4:  100  million books [10 trillion words]  

    1 million hours of video transcribed by Whisper 

    700 million images 

    680 million hours of multi-lingual audios  

    1.2 million songs powers their Jukebox trained on 

  Multi-modal input/output: text, images, audio, video 

   Algorithms: the recipe or steps or directions taken to organize the data of  

    the LLMs 

 Neural Networks: underlying computer system modeled on nodes like  

   human brain pulling the data together 

 NLP:  Natural language processing – talking/listening to AI 

  Workflow:  breaking things down into steps-automating processes 

 Prompt:  The text input and how you ask the LLM a question or give  

   directions [Prompt Engineering]– context, aim, qualifiers, audience,  

  Hallucinations: LLM makes something up, fabricated, nonsense 

  Sentient:  A sentient computer refers to an artificial intelligence  
   system that is self-aware and capable of thinking, feeling, and  
   perceiving the world around it like a human.  
 Agents:  AI enabled bots – what are the ten best restaurants  

    on the North Shore … book one for me 

  Automation: Zappier, n8n, link a series of Ai’s to do a process for you 

 Vibe Coding: is a modern software development approach that  
   leverages AI to generate functional code from natural language  
   prompts 
 

7A.  Specific Tools:   

 Speech to Text (STT):  TurboScribe.ai, many can do this now, 

https://youtu.be/9c7zh2MkslY?si=cl8kB4tQE3bceQHQ
https://developers.google.com/
https://developers.google.com/machine-learning/crash-course
https://youtu.be/NWONeJKn6kc?si=U-YAvBm_KI0wuUSR
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                   or OpenAI Whisper (accessed through Google Drive…) 

   Youtube now transcribes videos 

 Text to Speech (TTS): I use Word → View→Immersive Reader, Read Aloud,  

   Heygen, Synthesi, AI Studios, a Avatars/lip synch 

 Images Generators: Mid-Journey*, Photoshop FireFly, Nano-Banana*,  

   OpenArt AI [works well with Suno music generator] 

  Audio Generators: generate human sounding voices, in many languages 

    Eleven Labs*,HeyGen, Synthesia,  

   I use: MS Word →View→Immersive Reader→ Read Aloud  

 Music Genrators:  Suno AI*, Udio*, AIVA, and Soundful, Musicgpt 

 Video Generators:  Pollo Ai, KlingAI, Capcut, VEO3 [Google]*,Hailuo 02,  

   Runway Act 2, Sora OpenAI, Synthesia [lip synch, Avatars], Artlist,  

   Invideo AI, KlingAI, OpenArt.ai, et al. 

  Lip-synched Avatars Videos: HeyGen*, Synthesia, Creatify, Joggai,  

  Kling, Higgsfield, Kling, Dzine, Hedra, VEO3, Runway, Pippit 

   [text to video, image to video] 

 Video editors: Capcut, Filmor, DaVinci Resolve, Adobe Premiere (old) 

  Languages: Google Translate, AI with 80 languages, many AI programs will  

   translate now. 

  Workflow builders:  Zapier, n8n, [Automations: fixed workflow, Agents are  

   dynamic they can reason, choose…]  

  Vibe Coding: natural language builds code for you Vibe Coding: AI Coding Tools:  

   natural language builds code for you  

   1. Visual Studio Code (VS Code) – MS Copilot 

   2. JetBrains IDEs does Python,…  

   3. Neovim  

   4. Zed  or Cursor IDE or JetBrains IDEA 

   5. Base44.com it leans more toward “idea-to-app” rather than “code-all- 

    the-things”. 

  Other Tools that may be useful:  WordWall, Edcafe.ai, Quizlet, Grammarly,  

   Chatgpt for Educators 

 

Skills to master:   

  1) Prompting [Aim, Context, Rules],  

  2) Tools [desired input/outputs[,  

  3] Workflow [breaking large tasks into separate processes],  
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  4) Posting results online in formats others can use easily  

   (Word *.docx, and Acrobat pdf documents, jpeg (images), mp3 (audio),  

   mp4 (videos), Youtube & web page postings)  
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Overview & Focus: Building things with AI 

Focus of this presentation on 5 workflows or process actually building things AI  

  1) STT:  speech to text transcriptions, Translations 12 languages, TTS: text to  

   speech [Three tools: TurboScribe, Google Translate, MS Word-Read Aloud] 

  2) Google’s NotebookLM [makes study guides, podcasts, videos, and does  

   research],  

  3) Google’s Gemini Storybook – making illustrated stories → Youtube Videos 

   Take a proverb → story → Video 

  4) Making Shorts using HeyGen Talking/lip synched Avatars 

  5)  Making AI – Music, Making of “Wisdom’s Song” using Chatgpt & Suno AI 

 

 

 5. After-thoughts & Discussion Questions:  

     

  1A. Questions Raised by AI and my reticent response  

  1) What does it mean to be human?  
   2) What kind of relationships can one have with such systems?  
   3) In what ways can AI be helpful?  What are the downsides?  
   4) What about when the computer gets smarter than we are?   
   5) Will such systems delete humans after they surpass us?  
   6) Where will I get a job if AI takes away all the job opportunities? 
 
  2A.  Why I am not engaging such questions in this presentation?  
   Time limitations, Doing over Disengaging do-nothing critical stance,  
   Past history of negative neo-Luddite ETS responses [Greek/Hebrew Tutor CD- 
    Roms in the 1990s], 
  Institutional fears and shooting it down or hopes of monetizing it  
    – going for it after being forced by Covid to consider it.  
 3A. Open invitation to participate in BeL. Video recordings of instruction  

   ($150/hr), I travel to your place and record and then process it for BeL 

  4A. Audience reflections on AI (uses, potentials, and problems) 

 

   [If no discussion go off on Why Proverbs is Different and the need for 

   A Wisdom Literature genre for interpretive purposes] 
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To DO:  Make PowerPoint with Screen Shots so won’t have to go online if that  

   becomes a problem.  


